Detailed Steps for setting up Acknowledgment Merge Letters
This document details a methodology for setting up an automatic gift acknowledgment process. This
process allows you to run the gift export in FIMS and create gift acknowledgment letters of various styles
based on the individual acknowledgment code on each gift. Once the letters are created, you can run a
macro in MS Word to split the letters into individual files and place the letters in either or both the fund and
profile folders associated with the gifts. Automating this process will save time and allow you to concentrate
on content review instead of spending time on the process!
You might already have successfully completed many of the steps below and thus can swiftly finish the
process to complete the automation.
The overall process requires you to test the letter creation in Microsoft Word (MS Word) first before setting
up the autolaunch in FIMS. If the letters don’t work in MS Word, then having FIMS launch the master letter
will fail as well.

This session will cover the following:
•

FIMS: Run the Gift Acknowledgment – Export from the Process Tab in Unposted Gifts to
create a data file to use for creating the merge letters

•

MS Word: Using the exported data file, create the acknowledgment letter(s) in Word

•

MS Word: Test the merge letter(s) against the data export from FIMS

•

MS Word: Create a master Letter to launch all acknowledgment letters at one time

•

MS Word: Add the header to the master merge letter

•

FIMS: Install the macro files in MSWord if necessary using FIMS tool

•

MS Word: Run the macros to split the letters into the desired Windows folders.

•

FIMS: Run the export and this time fill in the Autolaunch Document field to test the
automatic letter creation

In FIMS: Run the Gift Acknowledgment to create a data file to use for creating the
merge letters – Export from the Process Tab in Unposted Gifts
Before you can create a merge letter in MS Word, it is necessary to have a data file available providing the
merge field names.
First, run the export you plan on using for your acknowledgment merge letters in FIMS.
Typically, acknowledgment letters are created before gifts are posted and therefore you would probably use
the Gift Acknowledgments – Export found on the Processes tab in Unposted Gifts.

If your policy is to post the gifts first, then the Gift History Export (located on the Reports menu) can be used
instead. Both exports provide the same fields in the export. This is helpful to remember in case some gifts are
posted before you create your letters.

More information and help on running the export can be found in online Help. This can be reached from the
Help Menu:

Exporting the data
•

For this step, run the export and save the data to the folder with a file name you intend to use in the
future.

•

Typically, the filename will be “gift.txt”.

•

Most of the time a file folder is set up to hold the merge data files on the C drive of your local PC**.

•

If you set the file location for your organization’s server, you are potentially causing additional work if
different people need to run the merge letters. Having a standard folder created on the C drive for each
person who will run merge letters will allow for standardization.

•

Many use a folder named “Data”, “FIMS-Data”,” Exports”, “Exported Data”, or something similar.

•

Maintaining files locally keeps the control of the data in your hands and you don’t run the risk of
someone running an export of the same name and overwriting your data.
**If you are in a Host*Net environment, save everything on your “S” drive – both templates and data.

•

For now, the Auto Launch Document field is left empty.

•

Run the Report to export your data.

•

When the export is complete you will see a similar message to this:

Tip: If you need to manipulate the exported data so that various acknowledgment codes or gift values
exist, remember that you can run your export from the Test & Learn database as well.
If you do that you can either create new fake gifts with specific criteria or edit posted gifts to have
particular values. As you create many different letters to handle different situations, sometimes it is
easier to create new gifts in the testing environment than it is to search for gifts that meet your
requirements among the historic gifts. When setting up letters for various situations, create a number
of test gifts containing all the variations of gift value, specific funds, batch codes, gift types, memorial
and honorariums, special project gifts, etc. Then you can have them all exported in the same data file
and test your merges without having to wait for a real gift with those requirements to appear.

In MS Word: Using the Exported data file, create the Acknowledgment letter(s) in MS
Word
It is not necessary to start your letters from scratch. You can take existing acknowledgment letters and convert
them to MS Word merge templates. Here is a sample simple gift acknowledgment letter:

To turn it into a merge template you follow these steps:
•

Open an existing acknowledgment letter in MS Word

•

Click the Start Mail Merge button on the Mailings Ribbon. Select Letters

•

Next Select Recipients and select Use Existing List.

•

Navigate and select the gift.txt file you exported in the first main step.

•

•
•

Highlight a field value like “North Main Street” and click on Insert Merge Field and select the merge
field in the list to replace the existing data with the merge field (Address1). Repeat for all of the
fields you wish to turn into merge fields. You might need to insert some fields not currently present
in your basic letter. In this instance Organization will need to be added.

You can review how the final letter will look by clicking on the Preview Results option on the Mailings
ribbon.
When complete, your new merge letter will look something like this:

•

An acknowledgment can be fairly complex and with the use of Rules you can manipulate the content:

The rule most frequently used is the If…Then…Else which allows you to insert words or phrases if certain
conditions apply.

For instance you can:
•

Include additional text if a gift exceeds a certain dollar amount

•

Include a paragraph of information if the gift was given to a certain fund

•

Include an invitation to an event if a particular merge field has a certain value

•

Include the gift acknowledgment large text block or the gift comment in certain situations

Once your letter is complete, save the letter as a word document (.doc or .docx).
Tip: Solution Article 2796 has some additional information that might be found useful.

In MS Word: Test the merge letter(s) against the data export from FIMS
It is best to test the new letter in the MS Word environment before heading back to FIMS. Close the newly
created document and reopen it. You will see a message like this:

•

Select> Yes

•

Your letter will open.

•

If the Mailings ribbon is not open, navigate and select Finish & Merge on the far right.

•

This set of options will appear:

If your data file does not contain too many gifts, click ok. If there are many, you might want to try a small
sample in case there are problems. You will have to click through many error messages if there is an issue, so
it is best to start with fewer records.
Once you have tested a small sample, merge the file again for all the gifts. If you used some conditional logic
in your letters, now is a good time to review the results. Remember you can use the Gift History export or
exports from the Test and Learn database if you need a wider variety of gifts to work with.

Create a Master Letter to launch all acknowledgment letters at one time
Using IF Then Else statements and the IncludeText field you only need to do one export from FIMS no matter
how many different acknowledgment codes are in the exported data.
•

Create a main form letter that will contain conditional merging commands (If Then Else
statements).

•

There will be one command in the main form letter for each different acknowledgment code in
FIMS.

•

With these commands you are telling MS Word, if the acknowledgment code is “X” then merge
the document letter “X.doc”.

•

This master letter will create the appropriate letter for each gift depending upon the
acknowledgment code of the gift.

You will need the following items before setting up the main form letter:
•

An acknowledgment code for each different type of acknowledgment letter you will be
writing set up the in Acknowledgment Code table in FIMS and gifts coded with these codes.

•

Print a Code Listing Report to have these codes handy.

•

Separate working merge document for all the different types of acknowledgment letters set
up exactly how you would like them to look including the merge fields.

•

Also create a list of the names of these separate documents for easy reference.

Creating the “Main Form Letter”
1. Export all the gifts you need to acknowledge from the Gift Acknowledgment Export in FIMS.
Write down the name of the document created as the data file, including the full path (i.e.
c:\gift.txt)
2. Open MSWord and a blank document.
3. Go through the regular steps of creating a form letter merge document. Open Data Source and
select the data file you exported (i.e. c:\gift.txt).
4. Position your cursor at the very top of the page.
5. Click Alt + F9 to display the field codes
6. Click on the Mailings menu and then the Rules option and choose “Insert Word Field”
7. Choose “If-then-else”
8. Click on Field Name down arrow and choose: AckCode
9. Comparison: Equal to
10. Compare to: put in one of your acknowledgment codes
11. In box labeled “Insert This Text” put xx

12. Select> OK.
13. Put the curser between the 2 x’s in the document.
14. Click on Insert/Quick Parts/Field – from Field Names select “Include Text”. Uncheck Preserve
formatting during updates.

15. Type the path and file name of the document that matches that acknowledgment code.
Note: the main form letter and individual thank you letters need to be in the same directory.
16. Go back to main form letter and carefully delete the x’s. Place the cursor at the end of the
statement you just entered.
•

Repeat steps 6-16 for each acknowledgment code (no returns is sometimes required between the
statements).

Note: An alternative to repeating those steps is to copy and paste the first line repeatedly and then carefully
edit the acknowledgment code and filename for the various letters.
•

Save the Main Form Letter and click on Merge to New Document.

•

Review the letters and print.

For streamlining future exporting and merging, set up a default in the Gift Acknowledgments Export with the
name of the main merge letter on the Send To Tab in the Auto Launch Document field. After the export runs,
MSWord will automatically open, the form letter will open, and the merge will be done all in one step.
The master letter could look something like this:

In this case, it is managing two codes: gen and sch. If the gift record in the export has an ackcode of gen, it
will create a letter using the gen.doc template. If it has a code of sch, it will use the sch.doc template. Any
other codes found in the exported data will produce blank pages.
If you are editing the IF THEN ELSE lines instead of creating them all via the steps, be sure to use the correct
extension on the letter filename. Depending on how recently you created or modified your letters, they might
have different extensions ( doc vs docx).
Tip: MS Word will compare the ackcode precisely as typed. Thus, you either have to include
variations of the code as seen above with “sch” or strictly require consistent code usage. If this
becomes a common problem during data entry, you can create a quick data grid to display the ackcode
and gift numbers and review them for consistency before processing your letters. Since typing capital
letters can be tedious during data entry, having your codes all in lower case is frequently easier to
manage. FIMS is case insensitive; MSMS Word is not.
Tip: Solution Article 2797 has some additional information that might be found useful. There are more
screenshots so some steps might be easier to follow!

Add the header to the master merge letter

1. Open the main merge document in MS Word and add the following paragraph at the beginning of
the letter:
<HEAD>path=«ExploreDir»;path2=«Fund1_ExploreDir»;asf=«ASF»;idcode=«IdCode»;giftnum=«Gif
tNum»;</HEAD>
Note: This paragraph includes five merge fields: ExploreDir, Fund1_ExploreDir, ASF, IDCode, and
Giftnum.
2. IMPORTANT: Do not include any spaces in this paragraph. Do not place the text into the Header or
Footer.
3. In order to prevent this initial paragraph from printing, select the paragraph and select Format /
Font. In the Font window, select the Hidden checkbox, and then click OK. It might be good to test
the macro out with the paragraph visible to start to be sure the correct values are populating the
individual letters.

4. At the end of the main merge document enter the following paragraph (and set it as hidden text as
well):
<BOTTOM>
5. Save the modified merge documents.
6. Merge your Acknowledgment letters as usual.
Note: If you need to edit the master letters, you can do so, but do not alter the <HEAD> or <BOTTOM>
paragraphs

In FIMS: Install the macro files in MS Word if necessary

•

If you haven’t installed the FIMS Macros into your installation of MS Word, open FIMS and run:
Tools\System Utilities\Admin Utilities\Update FIMS Macros.

•

You will see the following screen.

•

After closing MS Word as recommended, click Yes and the macros will be copied into your StartFolder.

•

It is necessary to run this tool for each user from their PC.
Note: Running it more than once will not cause harm.

•

Once it has been run, start MS Word and go to the Macros item on the View Ribbon:

•
•

Click the arrow, select View macros and you will see the following list of macros:

As you can see, there are two macros typically used for Gift Acknowledgments. The first one will save the letter
in the donor’s Profile Folder, the second will save the letter in the gift’s fund folder.
To use the macros you must add a header to your gift letters. This header will contain the information used by
the macro to split the document into individual letters, create files and either create or find the appropriate
folder to save the letter in.

In MS Word: Run the Macros to split the letters into the desired Windows folders.
To run the desired macro in the merged letters document, click on View / Macros. The Macro Selection window
opens. It is good to test this now instead of later.

Do one or both of the following:

•

If you want to save the letters to each individual Profile folder, select SaveAcknowledgments.

•

If you want to save the letters to each individual Fund folder, select SaveAcknowledgmentsFund.

Click Run. One of the following occurs:
•

The SaveAcknowledgments macro will test to see that each Donor has a Profile folder, and if not it
will create one. Then it will copy each letter to a separate document and save it into the appropriate
Profile folder with a file name that combines the Profile Alpha Sort Name with the Gift Number (for
example, ABC_Co._179.doc).

•

The SaveAcknowledgmentsFund macro will test to see that each Fund has a Fund folder, and if not
it will create one. Then it will copy each letter to a separate document and save it into the
appropriate Fund folder with a file name that combines the Donor’s Profile Alpha Sort Name and ID
code with the Gift Number (for example, ABC_Co._1135_179.doc).

Note: You can run both of these macros from the same merged document. Once you finish running the first
macro, you can run the second one immediately. You do not need to re-merge the document.

In FIMS: Run the Export and this time fill in the Autolaunch document field to test the
autolaunch

•

Now that the merge is working in MS Word, it is time to test it auto-launching from within FIMS.

•

To do this you will now fill in the Autolaunch document name on the Send to Tab of the export:

•

Before clicking Run Report, make sure the document is closed in MS Word.

•

After running the export you will receive a message like this letting you know how many records were
exports and/or skipped:

•

Then you will receive an export output message:

•

Select> OK and MS Word will open and merge the letters.

•

You might find it necessary to say ok to the merge. Once you do, the merge template will close and
only the final letter file will be open with all of the merged letters.

•

At this point you would review the letters, make necessary changes, print them and then run the
macro(s) to save them into the appropriate folders.

Misc. Tips and Tricks
If you experience the following error when exporting:

This is typically caused by MS Word merge letter that uses this file as its data source being open on your
desktop. Close the document in MS Word and retry the export. Alternately, the problem could be that the file is
open in Excel.

Solution article 2731 has information about how to resolve a Word 2013 merge error:
If you have recently upgraded you version of Microsoft Office to 2013, you may receive errors when trying to
auto launch documents from FIMS. Typically, these errors are 5677 and 5890. This may not resolve your
issue, but it is a common step necessary in order to use Word 2013 in the merge process.
Steps to resolve the auto launch errors:
1. Open Word 2013
2. Click on File > Options
3. In the Options pop-up window, under Start up options, uncheck the "Open e-mail attachments and
other un-editable files in reading view" box
4. Close Word and try to export and auto launch your document again

If you want to include Fund specific information in your letters:

•

There is only one fund field that exports in the standard gift history export or the gift acknowledgment
export and that is the Fund Comment field.

•

This field is found on the Fund 2 tab for the fund and is the first radio button labeled "Comments".

•

In the export, the column is labeled FundComment1,
FundComment2,FundComment3,FundComment4,FundComment5 for each of the 5 possible funds you
can have with a gift.

•

Typically information about the current projects or the focus of the granting activities of that fund are
entered in this field. This field is then included in the gift acknowledgment letter to inform the donor the
type of activity their gift might be supporting.

Fund and Profile folder renaming issues:

•

If you rename the Fund or Profile folder in Windows Explorer after FIMS creates it, FIMS will not be
able to find it when you click on the Fund or Profile folder again. This is because when you first click
the folder button for a Profile or Fund, FIMS creates a folder name that is unique to each Fund or
Profile that includes things like the Profile Id and Fund Id.
Tip: Some people create sub-folders underneath the main folder for their own organization
purposes. If you use one of the FIMS Word macros that automatically saves copies of Gift
acknowledgments or Fund Statements into these folders, FIMS will save it to the main
folder. Then you can manually move them into any sub-folder you've created.

•

For more information on setting up Fund and Profile folders and using FIMS Word macros for electronic
document management, see Solutions 220 and 348.

Acknowledgment Codes and ideas for letter creation:
Acknowledgment codes are typically used to identify the type of acknowledgment letter (or method of
communication) that will take place between the you and the donor. For example, the following codes might
be used for the following purposes:
Emal - the acknowledgment can be done via an email
Phon - the Executive Director will call and thank personally and the receipt letter will follow
Gen - the standard general letter will be sent
Mem- the letter set up to handle the special memorial name fields will be sent
Hon - the letter set up to handle the special honorarium fields will be sent
Stck - The letter that includes stock receipt information is used
Spec - A special letter sent to large donors will be send

Meet - A special letter mentioning their meeting with the Ed will be sent
Ann - a letter thanking them for a contribution to the annual appeal
AnnM - a letter acknowledging receipt of the Annual Dinner donation (non-gift)
AnMS - a letter acknowledging receipt of the Annual Dinner donation and an additional donation
( part gift and part non-gift)
•

Many letter variations can be created. They can indicate responses that should be made by particular
individuals using phone, email or letter. The word documents created can be written to have special
language, additional paragraphs, refer to the use of the funds, detail more information about the use or
purpose of the gift.

•

Foundations might include paragraphs detailing what the fund will be doing with the money- they
special project or focus for the year. You might be doing a fund-raiser and need to detail auction items
or how much of the "gift" is for a non gift ( a book, a ticket, a dinner, golf tournament, etc) and how
much is an outright gift. You might need to acknowledge the receipt of a non cash item.

•

All of these variations can be included in a letter and can be included based on the type of
acknowledgment code you have chosen.

Master Letter issues:
•

If you are using a master merge template pulling information based on the ack code, if you do not have
ack codes on every single record, there will be blank pages in the merged letters.

•

It might be necessary to move the Head and Bottom paragraphs to the individual merge letters if you
have difficulty getting the formatting to work properly in the merged letters with those elements on the
master letter.
Tip: Use the ack code as the letter name to make letter editing easier. It is far easier to go
looking for Gen.doc when you have issues with your general letter that looking for “standard gift
letter.doc”.

